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Introduction 
Welcome to the BHS Oral History Processing Manual! 
 
This manual is a step-by-step guide for processing oral history collections at BHS. Processing includes 
five stages of work: Auditing, Cataloging, Formatting Transcripts, Editing Audio and OHMS. This 
manual references the following documents all located in S:\LIBRARY & ARCHIVES\Cataloging-
Description-Processing\Oral History Cataloging\Oral History Manual and Associated Documents:  

• BHS Processing Manual 2015 revision 
• OHMS_Getting_Started_v2-1-19  
• OHMS-Indexing-guide-5-15-14 
• Narrator Instruction Template 
• Web Release Template 
• Transcript Copyright Preamble 
• OHMS-Transcript-Macro.bas 
• AT1_5_UserManual_with_2_0_newfeatures  
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Naming Conventions 
The oral history legacy assets are titled according to different file naming conventions. Going forward, 
please use the following conventions: 

• bhs_interviewID_lastname-firstname_YYYYMMDD_version.ext 
• The abbreviation indicates the stage and/ or purpose of the asset, which applies for both 

transcripts and audio recordings:  
• u: unedited  
• t: tracked changes 
• e: edited 
• a: access 
• o: OHMS 
• c: clip 

 Example: bhs_2011.019.095_basile ericka_20140604_u.doc 
• For multiple files transferred from media with multiple sides (like a series of cassettes), include a 

two-digit number corresponding to the side: bhs_interviewID_lastname -
firstname_YYYYMMDD-##_version.ext 

 Example: bhs_2011.019.095_basile ericka_20140604-03_u.doc 
• Do not create a web asset when it will be no different from an access copy. 

 
 

Before You Begin 
Ideally, before you begin the auditing phase, you should have the following documents (electronically or 
on paper): 

• Metadata Sheet 
o For legacy collections (like those in the NHPRC grant, ca. 2016) each narrator will get a 

"metadata sheet," which will be filled out by the processing archivist or intern. For new, 
incoming collections, each narrator has a metadata sheet filled out by the interviewer. 

o New metadata sheets can be created from the template found at  
BHS Working\LIBRARY & ARCHIVES\Cataloging-Description-Processing\Oral 
History Cataloging\Oral History Manual and Associated 
Documents\_NHPRC_BHS_InterviewMetadata_2016.docx 

• Release Forms  
o 1 release form already filled out by narrator during the interview. 

• Unedited Transcript or scanned transcript in pdf format with OCR applied 
o Paper transcripts were created by a transcription service 
o Transcripts have OCR applied and are saved as pdf by Project Archivist (When choosing 

“Recognize Text Using OCR” in Acrobat drop-down menu, edit the PDF Output Style to 
“Formatted Text & Graphics”) 

• Audio Recording 
o Recording of the interview as a single file in .mp3 format. 

In addition, you should have the following software installed on your machine: 
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• Archivists’ Toolkit 
• Microsoft Word 
• Audacity 
• ITunes 
• Adobe Acrobat (not Acrobat Reader) 

 
You should have access to the following network drives: 

• BHS Working/LIBRARY & ARCHIVES 
• BHS Working/ORAL HISTORY 
• BHS-ARCHIVE01/Archived Digital Assets 

 

Auditing with Transcript 
An audit is conducted to verify the accuracy of a transcript. (If a transcript is not available, advance to the 
Indexing workflow below.) During this initial phase, archivists perform the following tasks: 

• Format legacy collection transcripts or new transcripts received from the transcription service.  
• Check for errors made by OCR conversion or the transcription service. 
• For newly acquired collections only: Send transcripts, audio recordings and permission forms to 

the narrators. 
 
1. Create "Unedited" Transcript 

• Open transcript. This may be from a printed document converted to a pdf in Acrobat or one sent 
from transcription service in Word.  

o Example: Basile_Ericka_20140604 
• For a pdf source:  Open in Acrobat, go to “File,” “Save As,” “More Options” and select “Text 

(Accessible)” 
• Save a new copy of transcript with the letter "u" (for unedited) added to the end of the file name 

in \\BHS-ARCHIVE01\Archived Digital Assets\Mary\1-OH Collections in the collection folder.  
Renaming of the folder may be necessary to comply with standard folder title [accession #_brief 
collection title] 

o Example: bhs_2011.019.095_basile-ericka_20140604_u 
• For the text source: Open the saved txt file with Word and save a new .doc or .docx copy of 

transcript with the letter "u" (for unedited) added to the end of the file name in \\BHS-
ARCHIVE01\Archived Digital Assets\Mary\1-OH Collections in the collection folder.   

• Close the original transcript and work only from the "unedited" version in Word. 
 
2. Add Title, Header and Footer 

• Select all text and change to ArcherPro Book 12-point font with 1.5 spacing. 
• Add a title to the document, bold and centered, according to the following convention: 

 
Oral History Interview with [Narrator's Name] 
[DACS-Compliant Collection Title], [Asset ID] 
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Interview conducted by [Interviewer's Name] at the [Location] on [Month Day, Year] in 
[Neighborhood], New York 

 
o Example:   

 
Oral History Interview with David Alexander 

Crossing Borders, Bridging Generations, 2011.019.011 
Interview conducted by Amna Ahmad in her home on January 13th, 2012 in  

Bay Ridge, Brooklyn. 
 

• Add header and footer to the document in ArcherPro Book 12-point font, centered right. In the 
header, type "Unedited." In the footer, enter the page number. 

o Example header:   
Unedited 

o Example footer:   
58 

3. Search for Brackets 
• Brackets are sometimes used by the transcription company to enclose timestamps and words that 

are inaudible or possibly misspelled. 
• Search transcript for all brackets. Ctrl+ F [ 

o Example: Her name was Victoria [Lamagne?], and she was French. 
• Highlight all words in brackets so that you or the narrator can easily identify and change 

inaudible words. 
o Example: Her name was Victoria [Lamagne?], and she was French. 

  
4. Pre-format unedited transcript as Word document: 

• Remove Manual Line Breaks with Replace/More>>/Special/ buttons in Word 
• Use find and replace all to eliminate series of paragraph returns that can appear line-after-line in 

text. (There can be as many as six in a row. Begin with ^p^p^p^p^p^p and then replace with 
shorter strings until you've searched for two,  ^p^p , in a row.)  

• Determine whether names or initials of interview participants are consistent throughout. If they 
are not consistent, correct them. Once they are consistent, use find and replace all for a single 
paragraph return (^p). Do not include any text in the "Replace with" field. Then find the 
interviewer initials or name and colon and replace with: ^p and the proper formatting of the name, 
which is last name only in all-caps, colon. Repeat process for the narrator(s). (Also, find semi-
colons to see if they are meant to be colons.)  

• If the interviewer and narrator share the same last name, or there are narrators interviewed who 
share the same last name, add the first initial and a period before each last name, all-caps. 

• Find for the letters "rn" as Adobe Acrobat sometimes replaces the letter "m" where it shouldn't. 
Find for the number "1" as it may need to be a lower-case letter "l" or upper-case letter "I".  

• Find for multiple spaces in sequence. Reformatting can sometimes create 2, 3, or 4 spaces where 
only one is required. (NONE of our digitized transcripts require double-spacing between words.)  
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• Hanging Indents: For transcript readability, please select all of the interview content below the 
title, and move the hanging indent to .38" (.34" - .4" is in the acceptable range). You can do this 
by dragging the lower indentation mark along the ruler in Word, or on the "Home" controls in 
Word 2010: select the small arrow in the lower right corner of the "Paragraph" controls, go to 
"Indentation," "Special:," select "Hanging" from the drop-down menu, and in the "By:" window, 
enter: .38"   

• When sending to narrator for review of newly acquired, transcribed interviews, print a copy. This 
doesn't apply to legacy collections like those in the NHPRC project. 

 
5. Listen to interview recording with transcript when available: 

1. Create "Tracked" Transcript 
• Open the "unedited" transcript in Word and save a new copy of transcript with the letter "t" 

(for tracked) added to the end of the file name in \\BHS-ARCHIVE01\Archived Digital 
Assets\1-OH Collections in the collection folder. 

o Example: bhs_2011.019.095_basile-ericka_20140604_t 
• Open the audio recording. Audacity, Quicktime and Windows Media Player all have speed 

adjustment tools. They augment how fast the interview plays. Use the player's time counter 
for relevant timecode. 

• With the tracked transcript open, go to the "Review" tab of Word and select the "Track 
Changes" button. As you listen to the audio recording, follow along with the transcript. You 
should simultaneously be applying edits to the document, but also analyzing the interview 
content for cataloging and culling metadata content. This is indicated in the Cataloging 
section below. 

• About Verbatim Transcripts: We include the natural verbal stumbles—ums and ahs, pauses, 
and repetitions that we all do in normal conversation—so that the written version of the 
interview matches as closely as possible the orality of the audio recording. These kinds of 
things will be edited out if the interview is quoted or excerpted. 
About Inexact Transcripts: If we are processing a previously-accessioned analog transcript 
for digital distribution/publication and that transcript omits natural verbal stumbles or 
superfluous words, do not attempt to match the audio recording when auditing. If the 
transcript has left out clauses or sentences that shape or influence the conversation or our 
perception of the interviewer and narrators, please include them as you’re auditing. 

• For privacy, we redact for specific birthdate. (This does not include birth year.) For this 
redaction and any other sensitive issue you encounter, find the timecode in the audio 
recording. Type the timecode next to the suggested edit in the transcript and highlight in 
yellow. This step is essential, as it will help the archivist/technician identify segments to 
remove while editing the audio.  

• Correct highlighted words when possible. If you are unsure, leave the word highlighted for 
the narrator to correct. If narrator is unavailable, as they most often are with legacy 
collections, undo highlighted area and leave as bracketed area. 

• If you have a transcript with a series of question marks in or out of brackets, i.e. [???], and 
you can’t improve these to be the actual word or words then change the question marks to: 
 

"[inaudible]" or "[unintelligible]"  or for Spanish [inaudible] or [ininteligible] 
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and remove the highlighting. Use [inaudible] for the spoken words that are way off-mic or 
whispers. Or use [unintelligible] for words from mumblers or super-fast talkers.  

• In cases where there is an indication that the recording is paused or stopped, or there is a long 
pause in the interview or the interview is interrupted, but the audio is kept running, indicate 
that in the transcript thusly: 
 

“[Interview interrupted.]" or for Spanish [Entrevista interrumpida] 
 
 

• In cases where there is laughter in the interview and the transcription includes "[laugh]" or 
"[laughs]" or doesn't include a reference to it at all, indicate that in the transcript thusly: 

 
"[laughter]"   or for Spanish [risas] 

 
• If you find that you’re 4 pages into a formatted transcript, and you’ve been filling in so many 

omitted clauses and sentences that they add up to a new ½ page to a full page of formatted 
typing, alert the Project Archivist or a supervisor. 

• Be on alert for misspelled street names, schools and other local NYC organizations. Be sure 
to fact-check spellings before you correct. Use the following sources as reference: 

o BHS Finding Aids: http://brooklynhistory.org/library/wp 
and http://dlib.nyu.edu/findingaids/ 

• We have a glossary of terms. Check this first for challenging words, phrases, names. Add to it 
when you find an answer on the web or an authority. The glossary is for editing by anyone 
with the link: 
https://docs.google.com/spreadsheets/d/1rmPvVBwA5hIpL0ebg2puVUz3V6ZZ1DZ-
Xd5FHmW_P-s/edit?usp=sharing 

• If you're working with a newly acquired transcript that has been reviewed by the narrator, 
incorporate all of the narrator's edits, e.g. spelling corrections, redactions, etc. into the tracked 
transcript.  

2. Capitalizing race, ethnicity, social orders: 
o For editing of transcripts, please be symmetrical about capitalizing cultural, religious, 

racial or social orders such as: Jewish, Black, Caucasian and White Americans. 
o Many legacy transcripts are inconsistent about capitalizing “Black” and “White” when it 

refers to people and their various social arrangements (community, neighborhoods, etc.) 
When it is merely describing a color (skin or otherwise) make sure it is lower case.  

o Use the “Match case” function in Find/Replace to seek out these lowercase & capitalized 
words in your open documents. Please go one-by-one to the found words and do not 
indiscriminately use "replace all" during this process.  
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Cataloging an interview with transcription 
Cataloging the collection on an item/ interview level is a time-consuming phase. Be sure to leave extra 
time at the end of processing for quality control and review by Project Archivist, Managing Director of 
L&A and Oral Historian.  
 

1. Review  
o Return to the "tracked" transcript for review. Take notes on: 

 Narrator's or other identified person's date of birth and corresponding timecode. 
 Possible legal issues, such as stories detailing child abuse, etc. and corresponding 

page numbers. 
 Brief quotes from the interview and corresponding page numbers may help you 

compose summaries or bios, but pull-quotes will probably not be entered into 
catalog records. 

o Each narrator has a "metadata sheet." This could have been filled out by the interviewer 
or it may need to be filled out by you at this stage. The "metadata sheet" should usually 
be titled as follows: 
 BHS_Accession#_InterviewMetadata_Lastname-Firstname_YYYYMMDD.doc 

o After listening to the interview, attempt to complete as many fields on a new metadata 
sheet yourself by referencing your notes, the audio and the transcript. If narrator has 
supplied a metadata sheet, review the narrator’s sheet and add where applicable. 

o See that checkboxes in the processing checklist at the end of the metadata sheet are filled 
in; "Y" for yes or "N" for no, whenever appropriate. Leave blank when the task only 
applies to the Project Archivist or you are unsure. 

 
2. Write Notes  

o Read pages 25-26 and Appendix C-1 on writing Biographical History and Scope and 
Content notes in the BHS Processing Manual 2015 revision. Also apply style guidelines 
as indicated in the BHS Editorial Style Sheet, S:\STYLE AND CONTENT 
GUIDES\BHS EDITORIAL STYLE SHEET. 

 
3. Assign Authorities 

o Read pages 31-34 on assigning access points in the BHS Processing Manual 2015 
revision. 

o Keep your total number of topical subject headings to 9 or fewer. In total there should be 
no fewer than 8 and no more than 15 headings per interview. 

 
4. Review 

o Conduct a thorough review of all notes and authorities. 
o After the metadata sheet has been reviewed and corrected, a text version (.txt.) should be 

saved in addition to the Word document. 
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Formatting Transcripts 
During this phase, incorporate the narrator's revisions (if applicable) into the transcript and create access 
copies of the transcript for use in the Othmer Library and online. 

 
1. Create "Edited" Transcript  

• Open the "tracked" transcript in Word, go to the "Review" tab of Word, select the button with 
"Accept" followed by an arrow, select "Accept all changes in document."  

• Change the header of the document from "Unedited" to "Edited" and save a new copy of with 
the letter "e" (for edited) added to the end of the file name in \\BHS-ARCHIVE01\Archived 
Digital Assets\1-OH Collections in the collection folder. 

o Example: bhs_2011.019.095_basile-ericka_20140604_e 
2. Create "Access" Transcript 

• Save a new copy of the "edited" transcript with the letter "a" (for access) added to the end of 
the file name in \\BHS-ARCHIVE01\Archived Digital Assets\1-OH Collections in the 
collection folder. If there are two "edited" transcripts, combine them into one "access" 
version. Save as a Word 97-2003 Document (.doc) to reduce compatibility issues with Adobe 
Acrobat. 

o Example: bhs_2011.019.095_basile-ericka_20140604_a.doc 
o Add header and footer to the document in ArcherPro Book 12-point font, centered right. 

In the header, type "Access." 
o In the footer, below the page number add rights statement and a citation for the transcript 

in ArcherPro Book 8-point font, bold and centered left. NOTE: THERE ARE NO BLANK 
LINES BETWEEN PAGE NUMBER AND RIGHTS STATEMENT. THERE ARE NO 
PARAGRAPH RETURNS BELOW THE END OF THE RIGHTS STATEMENT. Format as 
follows: 

 
This transcript is hereby made available for research purposes only.  
 
[Last name, First name], Oral history interview conducted by [Interviewer First name Last name], 
[Month day, YYYY], [Title of Oral History collection], [Asset ID]; Brooklyn Historical Society.  
 

o Example header:   
Access 

o Example footer:   
58 

This transcript is hereby made available for research purposes only.  
 
Basile, Ericka, Oral history interview conducted by Charles Shafer, June 4, 2014; Crossing 
Borders, Bridging Generations Oral History Collection, 2011.019.095; Brooklyn Historical Society. 
 

 
 

• Open the Transcript Copyright Preamble and copy the graphics and text. Be sure to 
customize the citation section of the preamble with the accurate Collection Title and 
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Accession Number and the Guidelines for Use section, #3.  Paste at the beginning of the 
"access" transcript. YOU DO NOT NEED TO CREATE UNNECESSARY PARAGRAPH OR 
PAGE BREAKS WITHIN THE PREAMBLE TEXT. 

• Remove narrator's month and day of birth and replace with [date redacted for privacy]. 
o KATHERINE AMBIA: And they looked in Park Slope, and in those kinds of 

neighborhoods, and at the time Park Slope was still too expensive for them, so they 
bought a house in Sunset Park.  And my brother and I were born on [date redacted for 
privacy] 1900. 

• AT THE CLOSE OF THE FINDING AID PROCESS FOR THE COLLECTION AND 
WITH APPROVAL FROM THE PROJECT ARCHIVIST: Save another copy of the "access" 
transcript as a PDF in \\BHS-ARCHIVE01\Archived Digital Assets\1-OH Collections in the 
collection folder. 

 

Indexing 
• Indexing is time consuming and only recommended if transcripts are not available. 
• Please see OHMS-Indexing-guide-5-15-14 for guidance. 
• REMINDER: Read the OHMS index guide at S:\LIBRARY & ARCHIVES\Cataloging-

Description-Processing\Oral History Cataloging\Oral History Manual and Associated Documents 
• Listen to the interview to identify the general themes of the interview and think about how to 

subdivide the discussion into segments. The beginnings of these segments are our index title 
points. 

• You may find it helpful to create rough ideas of your segments with relative time-code index 
points at the beginning (TC-in) of the segment. Take notes! They will guide how you make final 
decisions about the index titles of the interview. You may also find that after hearing an entire 
interview, some titles can be joined together. Or a couple titles may need to be extracted from 
where there was only one, initially. A small theme may seem like a distraction and tangential to a 
larger theme of the conversation, so that small theme can be dismissed in favor of the stronger, 
overarching theme. (Subject headings can later be assigned to that insignificant theme, so don't 
forget about that theme entirely.) 

• Enter your ideal index points and titles organized by a time-code and title in a working document 
provided by the Project Archivist. This will be a spreadsheet usually, but could be a worksheet as 
well. 

• Your segment title should be no longer than 89 characters (or length of this sentence). For some 
examples of constructing titles and keeping titles concise, please see 
http://cbbg.brooklynhistory.org/listen, click on the "SEARCH SYNCHRONIZED AUDIO AND 
TRANSCRIPT" of some interviews and move the toggle switch on the right to "INDEX." 
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Cataloging an interview with an index 
Cataloging the collection on an item/ interview level is a time-consuming phase. Be sure to leave extra 
time at the end of processing for quality control and review by Project Archivist, Managing Director of 
L&A and Oral Historian.  
 

1. Review  
o Return to the audio for review. Take notes on: 

 Narrator's or other identified person's date of birth and corresponding time-code. 
 Possible legal issues, such as stories detailing child abuse, etc. and corresponding 

page numbers. 
 Brief quotes from the interview and corresponding time-codes may help you 

compose summaries or bios, but pull-quotes will probably not be entered into 
catalog records. 

o Each narrator has a "metadata sheet." This could have been filled out by the interviewer 
or it may need to be filled out by you at this stage. The "metadata sheet" should usually 
be titled as follows: 
 BHS_Accession#_InterviewMetadata_Lastname-Firstname_YYYYMMDD.doc 

o After listening to the interview, attempt to complete as many fields on a new metadata 
sheet yourself by referencing your notes, the audio and possibly the index titles. If 
narrator has supplied a metadata sheet, review the narrator’s sheet and add where 
applicable. 

o See that checkboxes in the processing checklist at the end of the metadata sheet are filled 
in; "Y" for yes or "N" for no, whenever appropriate. Leave blank when the task only 
applies to the Project Archivist or you are unsure. 
 

2. Write Notes  
o Read pages 25-26 and Appendix C-1 on writing Biographical History and Scope and 

Content notes in the BHS Processing Manual 2015 revision. Also apply style guidelines 
as indicated in the BHS Editorial Style Sheet, S:\STYLE AND CONTENT 
GUIDES\BHS EDITORIAL STYLE SHEET. 

 
 

3. Assign Authorities 
o Once your index titles are approved, go back through your notes and playback parts or 

the entire interview to gather subject headings authorized by the Library of Congress. 
These will be assigned in your metadata sheet. Keep your total number of topical subject 
headings to 9 or fewer. In total there should be no fewer than 8 and no more than 15 
headings per interview. 

o Read pages 31-34 on assigning access points in the BHS Processing Manual 2015 
revision. 

o As you are culling authority headings, don't dismiss the asides and tangents that you may 
have correctly dismissed during your gathering of index titles. Headings can be attached 
for the aside or tangent even if they seem out of place next to the rest of your more 
relevant headings. 
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4. Review 

o Conduct a thorough review of all notes and authorities. 
o After the metadata sheet has been reviewed and corrected, a text version (.txt.) should be 

saved in addition to the Word document. 
 

Batch Conversion of WAV files to MP3 
Use iTunes for batch conversion of WAV files to MP3 
1. Open iTunes 

 
2.  iTunes conversion settings: 

• Choose iTunes > Preferences 
• Click General 
• Click Import Settings… 
• For Import Using select MP3 Encoder 
• For Setting choose Higher Quality (192 kbps) 
• Click OK 
 

3. Confirm iTunes save settings [This will prevent iTunes from creating a copy of the source file, 
thereby conserving memory.]: 
• In the Preferences window, click Advanced 
• Uncheck the box next to Keep iTunes Media folder organized 
• Uncheck the box next to Copy files to iTunes Media folder when adding to library 
• In the field iTunes Media folder location click Change 
• Choose the desired destination drive/folder for the MP3 files as the location 
• Click OK 

 
4. Select, drag, and drop WAV files into the iTunes library. 

 
5. Right click (control + click) and select Create MP3 Version  

 
Editing Audio 
An open-source program, like Audacity, is recommended for editing audio.  
 
Edit Access Copies 

• Using the "access" transcript as your guide, replace all of the redacted segments from the 
mp3 audio recording with test tone. Recommended amplitude of test tone is 0.1 dB. 

• Export and edit mp3 access copy. For multiple files transferred from media with multiple 
sides, assemble all files into one with a 2-second silent gap between the end of recorded 
sound in one file and the beginning of recorded sound in the file that follows. Save the access 
copy formatted as an mp3 (sampling rate: 44.1 kHz, bit rate: 96 kbps per channel or 192 kbps 
in stereo) in \\BHS-ARCHIVE01\Archived Digital Assets\1-OH Collections in the collection 
folder. 
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o Example: bhs_2011.019.095_basile-ericka_20140604_a 
 

 
Enter Metadata 
Use iTunes to enter audio file metadata. 
 
1. Open iTunes. If files are already in iTunes skip to Step #4. 
 
2. Confirm iTunes save settings [This will prevent iTunes from creating a copy of the source file, thereby 
saving memory space.]: 

• In the Preferences window, click Advanced 
• Uncheck the box next to Keep iTunes Media folder organized 
• Uncheck the box next to Copy files to iTunes Media folder when adding to library 
• In the field iTunes Media folder location click Change 
• Choose the destination drive/folder for the MP3 files as the location 
• Click OK 

 
3. Select, drag, and drop WAV and MP3 files into the iTunes library. 
 
4. Enter batch metadata: 

• Select all the files in a given collection 
• Right click (control + click) on the selection 
• Select Get Info 
• In the Artist field type “Brooklyn Historical Society” 
• In the Year field enter the year in which the interview was conducted 
• In the Album field type “[Collection name, accession number]” 
• Click Ok 

5. Enter file-specific metadata:  
• Select all the file/versions (WAV, MP3 access) of one interview  
• In the Song Name field type “[Narrator Name (First Last)] Oral history interview” 
• In the Comments field type “Interview conducted by [Interviewer First name Last name], 

[Date of interview (Month DD, YYYY)]”  
• Click Ok 

6. Comments metadata on PC:  
• Using a Windows PC, go to the folder in Archived Digital Assets, and right click on MP3 

file. 
• Select Properties from menu. Select the Details tab. It is likely that the Comments you 

entered in iTunes do not appear in the Windows Comments field.  
• Copy the iTunes Comments and paste into Windows Comments.  
• Click Apply and OK 
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6. WAV metadata fields have not been embedded in a standard format within the file in the way that 
most MP3 metadata fields are embedded today. The iTunes metadata is often discarded in several 
other applications, including Windows file properties. Do not attempt to recreate metadata using other 
applications once it has been added to iTunes. 

7.  

OHMS 
Prior to working in OHMS, be sure to watch the instructional videos released by the University of 
Kentucky: http://www.oralhistoryonline.org/documentation.  
 
Login for OHMS: 
https://ohms.uky.edu/index.php?logout=true 
UN: [unique to user] 
PW: [unique to user] 
 
The work in OHMS is broken down into the following phases: 

1. Preparing Transcripts for OHMS 
2. Creating Records  
3. Syncing  
4. Indexing 

 
Preparing Transcripts  
1. Delete Title, Header and Footer, and preamble 

• Save a new copy of the "access" transcript with the letter "o" (for OHMS) added to the end of 
the file name in \\BHS-ARCHIVE01\Archived Digital Assets\Mary\1-OH Collections in the 
collection folder.  

o Example: bhs_2011.019.095_basile-ericka_20140604_o 
• Delete title, header and footer, and preamble. Create or leave one paragraph break at the top 

of the first page.  
• If any of the names before the colon in a transcript have an accent mark or were created with 

a symbol in Word, this may have to be changed to a standard keyboard-typed letter to 
preserve the bold name formatting that OHMS produces. (The accents/symbols should 
remain as is in the Access version of the transcript.) 

 
2. Delete Timestamps 

● There are usually timestamps markers every 5 minutes.  
o Example: [00:00] [15:00]  

● Find timestamps by searching colon plus zero - Ctrl+ F :0. Delete timestamps.  
● Find remaining timestamps searching for left bracket -  Ctrl+ F [. Delete remaining timestamps. 
● Check for extra spaces or line breaks created by removal of timestamps. Delete all extra spaces 

and line breaks, but be sure to keep one space in between periods and the following sentence. 
o An alternative method to remove all time stamps:  enable wildcard searching on MS 

Word and then type: \[??:??\] in the find field, and nothing in the replace field. Scan the 

SAA M
us

eu
m A

rch
ive

s S
ec

tio
n W

ork
ing

 G
rou

p E
xa

mple

http://www.oralhistoryonline.org/documentation
https://ohms.uky.edu/index.php?logout=true
mailto:library@brooklynhistory.org


14 
S:\LIBRARY & ARCHIVES\Cataloging-Description-Processing\Oral History Cataloging\Oral History Manual and Associated 
Documents 
2017-06-20  

list to make sure nothing is being grouped into that that shouldn’t be, and then click 
“Replace all.” Make sure that all extra spaces are deleted when you replace them. 

 
 

3. Enable Macros 
● Click on the File tab and select Options underneath Help.  
● In the new Word Options window, select the last option, Trust Center. 
● Click the Trust Center Settings button towards the right of the window. 
● Under Macro Settings, select Enable all macros and click OK. 

o Note for Macs: Skip the above steps. In the Mac version of MS Word, click the Word tab 
and select Preferences from the drop-down menu. Then, click the Security button. Either 
uncheck the box next to ‘Warn before opening a file that contains macros’ or remember 
to press ‘okay’ if the notice pops up while you are configuring for OHMS. 

 

 
 
4. Change AutoCorrect Functions 

● Click on the File tab and select Options.  
● In the new Word Options window, select the third option, Proofing.  
● Click the AutoCorrect Options button. 
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● In the AutoCorrect window, under the tab, AutoFormat As You Type, unclick the boxes 
“Straight quotes” with “smart quotes” and Hyphens (--) with dash(-). 

● Still in the AutoCorrect window, move from the tab,  AutoFormat As You Type to Autoformat. 
Repeat the process:  unclick the boxes “Straight quotes” with “smart quotes” and Hyphens (--
) with dash(-). 

o Note for Macs: ‘AutoCorrect’ can be found in the drop down menu under the Tools tab. 
After you open it, follow the same steps as in the PC version. 

                    
 
5. Run Macros 

● Under Developer tab, Click Visual Basic.   
● If you do not have the Developer tab, go to the View tab and select the Macros button on 

the far right side. From the pull-down menu, select View Macros. 
● Under Macro name: enter OHMS_macro and click Create.      

● In the new window, right click on Normal and select Import File. 

              
● Under the Files of type pull-down menu, select All Files (*.*). 
● Select OHMS-Transcript-Macro.bas and click Open.  
● Close out of the Visual Basic window.  

o Note for Macs: The Mac version of MS Word does not appear to allow you to import the 
file. Open ‘OHMS-Transcript-Macro.bas’ as a plain text document and then copy and 
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paste the entire thing. (Shortcut: press Command+A on the keyboard, and then press 
Command+C.). 

● Still under the Developer tab, click the Macros button.  
● If you do not have the Developer tab, go to the View tab and select the Macros button. 

Click on View Macros. 
● Select Ohms_textprep_final_final and click Run. 

 
6. Save Two Copies 

● Click on the File tab and select Save As 
● Enter file name with the letter "o" (for OHMS) added to the end of the file name.  
● Under the Save as type pull-down menu, select Plain Text and click Save. 
● Save into \\BHS-ARCHIVE01\Archived Digital Assets\Mary\1-OH Collections in the collection 

folder. 
● In the File Conversion window, select Other encoding, then Unicode UTF-8. Click OK. 

 

 
 

● Click on the File tab and select Save As. 
● Under the Save as type pull-down menu, select Word Macro-Enabled Document.  

o Note for Macs: In the coming steps, if you have trouble uploading the Plain Text 
document to OHMS, open it in TextWrangler and save again as Unicode UTF-8. 

 
Creating Records 

• Login into OHMS: https://ohms.uky.edu. 
• In the Interview Manager tab, click New. 
• Most OHMS metadata fields are not visible to the public. Only enter information in the following 

fields: 
o Title 

 Enter Oral History Interview  with [Narrator's First name Last Name]  
o Accession Number  

 Enter Asset ID 
o Interviewee  

 Enter First Name Last Name 
o Interviewer 

 Enter First Name Last Name 
o Interview Date 
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 Enter Year [YYYY], Month [MM], Day [DD] of interview 
o Media Format  

 Select Audio 
o Media Host  

 Select Host 
o Rights 

 Enter "This transcript and audio recording is hereby made available for 
research purposes only. For more information, contact Brooklyn Historical 
Society at library@brooklynhistory.org." 

 Note: If you do not have a transcript to upload with audio in OHMS then proceed 
to the rights statement on page 18. 

• Click Save. 
 
2. Upload Transcript 

• Find your new record listed in the Interview Manager tab.  
• In the transcript column, click Upload. 
• Select the Plain Text formatted transcript and hit Save. 

 
3. Upload Audio 

• An easy method of uploading audio to the BHS server is via an FTP. Download an FTP program 
such as http://winscp.net/download/winscp555setup.exe. 

• You will be prompted to enter user/ connection information. Enter as follows: 
o FTP username: libraryassets@brooklynhistory.org 
o FTP password: BHSLIB642$ 
o FTP server: ftp.brooklynhistory.org 
o FTP & explicit FTPS port: 21 

• This will grant access to the central location for all library assets 
(brooklynhistory.org/library/assets), including .mp3 files of oral history audio, .pdf files of oral 
history transcripts, and OHMS .xml files. 

• Drag the .mp3 file to upload window. Do not create subdirectories or folders for the assets; they 
should all be in the assets folder. 

• Return to the Interview Manager tab in OHMS. Click on Metadata in the Metadata column of 
your record. 

• In the Media URL field, enter http://brooklynhistory.org/library/assets/ followed by the file 
name. This link points OHMS to the audio file on the BHS server.  

o Example:  http://brooklynhistory.org/library/assets/bhs_1994.006.32_wilson-
delone_19931110_a.mp3 

• Click Save. 
 
Syncing in OHMS 

• The best instructions for syncing are found on pgs. 15-17 of the OHMS_Getting_Started_v2-1-
19 manual. 

• Practice syncing on a test record. 
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• After completing the sync, click Save. 
 
Indexing in OHMS 

• Follow the "Creating Records" for OHMS instructions above, with the following exception: 
• In place of the information for rights metadata as stated above, please use: 

 Enter "This index and audio recording is hereby made available for research 
purposes only. For more information, contact Brooklyn Historical Society at 
library@brooklynhistory.org." 

 
 

Quality Assurance 
• Leave time to review all metadata generated by staff and interns during syncing and indexing. 

Editing for clarity and consistency is likely to be necessary.  
 
Link from Finding Aid 

• In the finding aid, create a link to OHMS. 
• See pages 144-146 in AT1_5_UserManual_with_2_0_newfeatures for guidance. 
• The extent indicated in a finding aid for a collection of digitized oral histories should lead with 

digital storage size in gigabytes, in the allotted number of files, total running time, and physical 
size measured in linear feet and number of boxes.  

Example: 46.79 gigabytes in 133 files, total running time: 34 hours, 2 minutes, 59 
seconds; 2.5 linear feet in 6 boxes 

 
XML from OHMS 

• XML should be exported from OHMS to the same central location of library assets on the FTP 
server. 

• In the OHMS Interview Manager screen, choose several synchronized or indexed titles and select 
the batch action "Export Selected Interviews as XML." XML can also be exported one-by-one by 
clicking the XML link in the export column in the OHMS Interview Manager. 

• XML files will likely download to a Downloads folder on your workstation. Follow the 
instructions above for logging into the ftp server, then drag and drop XML files for uploading to 
library assets folder of ftp server. 

APPENDIX for narrator outreach: 
 
Burn Audio CDs 
In iTunes, create a narrator-specific playlist of all associated mp3 files. Select Burn Playlist to Disk. 
After burning, label audio CDs with solvent-free marker. Include the narrator’s name, asset ID number, 
interview number, CD number and Files (A, B, C, and D etc.).  
Example: Alicia Ohs - 2011.019.100 - Interview #1 - CD #1 - Files A-B 
Example: Alicia Ohs - 2011.019.100 - Interview #2 - CD #2 - File A 
Place burned CDs in CD sleeves and then in small, padded mailer. 
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On a BHS label, write narrator's name and affix label to padded mailer. 
If the narrator requests, mp3 and transcript files can be delivered via the BHS Dropbox account.  
 
Create Narrator Instruction Letter and Web Release 
To generate a letter, use the Narrator Instruction Template. 
In the letter, be sure to change the date, name of narrator, name of interviewer and date of interview.  
Open Web Release Template and fill in narrator’s name, accession number and date.  
Print letter and release form on BHS letterhead.  
 
Send to Narrator 
Assemble a packet for the narrator in large brown mailer. Package should appear professional and 
official. Include the following: 
A copy of the "unedited" transcript. 
Narrator instruction letter. 
Web release form. 
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